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Los Screencast o capturadores de pantalla

Permiten la captura automática de lo que está sucediendo en la pantalla del ordenador. Además, en la mayoría de los casos también podremos añadir texto y audio a los mismos, lo cual los convierte en una herramienta fundamental para el desarrollo de tutoriales multimedia.

Entre los programas más conocidos nos encontramos con Camtasia Studio con el cual podremos hacer tutoriales en diferentes formatos de vídeo, flash, etc., por lo que se nos plantea como una herramienta ideal para la realización de videocast.  Adobe  Captivate, por otro lado,  nos permite la captura automática de pantallas, así como la elaboración de presentaciones multimedia. 
Introducción a Adobe Captivate.

1. Tipo de grabaciones

· Demostración: captura de forma automática aquellos elementos que van sucediendo en la pantalla, añadiendo leyendas, movimientos de ratón, y cuadros resaltados.

· Simulación de evaluación

· Simulación de formación

· Personalizado: permite crear proyectos híbridos con partes demostración y partes de simulación.

2. Diseñando la grabación.

· Grabar o creación de un nuevo proyecto> Simulación de software> Pantalla completa > Demostración > Configuración

· El idioma definido, por defecto, para la captura de leyendas es el inglés. Lo podemos cambiar en “Configuración > Configuración global> Preferencia de ortografía>idioma del diccionario principal”

· Seleccionar “Configuración> Grabación automática”

· En caso de que queramos añadir sonido sería conveniente desmarcar “Grabar pulsaciones de tecla”

· Si queremos grabar una narración durante la grabación pulsar “Grabar narración” y sistema de grabación “Micrófono” “Entrada de línea”, etc.

· Pulsar “grabar”. Para parar la grabación “Pausa” y para terminarla “fin”
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3. Leyendas de texto

· Si hemos optado por la incorporación automática de leyenda “Configuración> Modos> Añadir automáticamente leyenda de textos” podremos optar, posteriormente, a su modificación. Para ellos nos pondremos en la “Diapositiva”, pulsaremos el botón derecho del ratón y seleccionaremos “Propiedades”. En “opciones” podremos modificar el tiempo de aparición, así como el efecto de transición al aparecer o desaparecer la “Leyenda de texto”

· También podremos añadir nuevas leyendas de texto  “Insertar > Leyenda de textos”

4. Grabación de audio

Captivate nos ofrece varias oportunidades para añadir 

· Grabar en el momento que realizamos la grabación.

· Grabar audio en una diapositiva concreta, lo cual podría ser más sencillo para sincronizar audio y duración de la imagen. 

· Incorporar audio al proyecto, posteriormente, al proceso de grabación “Audio>Grabar proyecto>Grabar

· Audio en diapositiva. Nos ponemos encima de la diapositiva y seleccionamos “Audio> Grabar esta diapositiva >Grabar”.  

· Tanto en la grabación en diapositiva como del proyecto podemos acceder a un pequeño estudio de grabación que nos permite “cortar” “Seleccionar audio de la biblioteca”, “Importar”. También podemos importar, desde el menú superior,  directamente un sonido desde “Audio>importar”
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5. Incorporar diapositiva en blanco.

La incorporación diapositivas después de la grabación, nos puede ser útil, por ejemplo, para añadir al inicio del tutorial el título, la autoría,  la visualización óptima del documento, datos de contacto,  etc., recomendaciones de uso…

· Ubicarnos en el lugar que queremos poner la diapositiva vacia, pulsar en “Insertar> Diapositiva vacía” 

· En el lado derecho de las diapositivas la barra que nos indica la localización de cada uno de los materiales.  “I” nos indica el margen izquierdo del objeto, “S” el  margen superior, “Anc” el ancho, y “Al” el alto. Conociendo esos datos podremos colocar en el sitio exacto el objeto que queramos

[image: image3.png]L] 5] anfEs] ] @ zoomfion v





6. Incluir un menú en el proyecto.

La versión 3 nos permite la creación de un menú en la presentación que permitirá al usuario navegar por las diferentes diapositivas,  establecer enlaces a páginas web o correos electrónicos o abrir otros proyectos

· “Proyecto > Máscara > Menú >Mostrar Menú >

· Poner nombre a la leyenda y pulsar añadir.

· Pondremos nombre al “submenú” en “Leyenda” y seleccionaremos la acción a realizar
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La versión 4 de Captivate se puede realizar un índice pero sólo podemos enlazar con las diapositivas “Proyecto> Índice> Mostrar Índice > 

7. Incorporar preguntas

Captivate nos permite incorporar diferentes tipos de preguntas al tutorial. 

· “Insertar>Diapositiva de pregunta”, elegimos el tipo de pregunta y si queremos que sea calificada o de encuesta.

· Opción múltiple: deberemos añadir el nombre de la pregunta, la pregunta que queremos realizar, las diferentes posibilidades de respuestas “Añadir”, si queremos que la respuesta sea única  y marcaremos la pregunta respuesta.
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· Opción verdadero/falso: igual que en el modelo anterior tendremos que añadir el nombre de la pregunta, hacer la pregunta e incorporar las posibles respuestas.

· También podemos realizar otros modelos de preguntas: relleno de espacios en blanco, respuesta corta, asociación, etc.

· En los diferentes tipos de preguntas tenemos la  opción de  definir las acciones que hay que se producirán si el usuario acierta la respuesta “opciones”, así como establecer un tiempo límite para la respuesta “Informes”.

8. Hacer el proyecto accesible


Una de las ventajas de Captivate es que nos permite que el tutorial sea accesible.

· Situarnos encima de la diapositiva y,  posteriormente, nos dirigimos a “Diapositiva> Propiedades >Accesibilidad”

· Podremos insertar de forma automática el texto que aparezcan en:

· las leyendas textuales

· en las notas “Diapositiva>Propiedades>Notas”

· de los subtítulos (solo en las diapositivas con sonido) “Audio> Audio avanzado >”. Seleccionar la diapositiva con sonido y seleccionar “Mostrar audio de nivel de objeto y seleccionar  [image: image6.png]
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· También podremos optar por añadir de forma manual el texto de accesibilidad.

9. La publicación

El fichero que viene definido, por defecto, en Adobe Captivate 3 es el formato (cp), que será nuestro instrumento de trabajo. 

Dentro de las posibilidades que se nos ofrecen para la publicación de nuestro proyecto se encuentran el flash (swf) y la del fichero independiente que sería un fichero ejecutable (exe).  La versión Word no permitiría guardar todos los textos incluidos en las leyendas, notas, etc.


La versión 4.0, además, nos permite convertir el tutorial, de forma automática, a un fichero pdf multimedia (con problemas de márgenes pues deberíamos configurar el tamaño folio en nuestro Adobe Profesional)

· “Archivo > Publicar “, elegir formato

· Es interesante consultar los datos que nos aparecen en “Información del proyecto”, sobre todo la que tiene relación con la “Resolución”, pues ese dato nos puede servir para una configuración adecuada si queremos hacer un pdf multimedia.

· En “Preferencias” podremos configurar aspectos como:

· Grabación

· Características generales donde podremos incluir aspectos como título del proyecto, autor, derechos de autor, descripción, etc.

· Proyecto. En el subapartado “Inicio y fin” podremos cambiar la pantalla que queremos que aparezcan en el momento de cargarlo. Por ejemplo, podremos añadir un flash (swf) que hayamos realizado, el logo de la biblioteca, etc., ya sea en formato flash o imagen. 
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Hacer un tutorial con Camtasia 6


Entre las posibilidades que nos ofrece Camtasia se encuentra.

· Hacer tutoriales a partir de la captura automática de pantallas.

· Grabar de forma automática la grabación de un Powerpoint para cambiarlo de formato (avi, swf, etc.).

· Crear un escenario donde presentar tutoriales y material multimedia (Theater)

· Crear menús para Cd-rom


A la hora de hacer un proyecto de captura automática de pantalla deberemos tener en consideración aspectos como: definir el área de grabación, definir la grabación de audio, el formato de grabación.

Configurar formato de grabación

Camtasia nos permite grabar el proyecto en dos formatos Avi y Camrec.  El segundo será el más adecuado si posteriormente queremos manipular el documento o grabarlo en otros formatos como mp4, swf, etc.

Barra de grabación
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Área de grabación

Podremos seleccionar cuatro modos para definir el área de grabación:

· Full Screen: grabará la pantalla completa del ordenador.

· Custom: nos permitirá definir la pantalla de grabación a partir de un cuadro que podremos mover en la pantalla para adaptarlas a nuestras  necesidades.
· Dimensions: ingresaremos la resolución que queremos grabar.

· Select: nos permitirá definir de forma automática un área determinada.

Área de sonido 

Lo primero que tendremos que hacer es activar en nuestro ordenador activar en nuestro ordenador las herramientas de grabación que vamos a utilizar

· Windows XP

· “Inicio> Todos los programas> Accesorios > Entretenimiento > Control de volumen.”

· “Opciones > Propiedades > Grabación. Seleccionar “Entrada trasera”, “Micrófono”, “Mezcla estéreo”.

· Windows Vista

· “Inicio> Equipo>  Abrir el panel de control> Sonido> “, pulsar botón derecho de ratón

· “Mostrar dispositivos deshabilitados /Mostrar dispositivos desconectados> Stereo mix” 

Una vez configurado nuestro ordenador deberemos indicar en configurar en el programa la opción de  grabación que deseamos utilizar (micrófono, entrada trasera, etc.)
· “Audio>  Options “. Podremos optar entonces por “Speaker audio (What you hear)”, que grabará todo el sonido que se esté reproduciendo en nuestro ordenador o “Manual imput selection” y, posteriormente, elegir entre “Mezcla estéreo, micrófono o entrada trasera”.

· También deberemos indicar el volumen de la grabación, así como el formato y calidad del mismo.
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Grabar webcam 

Nos permite grabar directamente de la web incorporando lo grabado al tutorial. “Record the screen>  Tools> Capture> Camera”, seleccionar la cámara correcta.

Para definir la barra los efectos que queremos que aparezca deberemos definirlos de la siguiente manera.

· “Record the screen>  Tools>Recordin Toobars”.
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En el menú de efecto podremos establecer los criterios relacionados con los efectos de la grabación, con el sonido o con el curso, nos encontramos, por ejemplo, la posibilidad de incoporar  una pizarra,  definir el estilo del curso, definir puntos de navegación par adespués  poder definir una tabla de contenidos,  definir punto de cortes, , etc. 
· “Record screen>Effects> Annotation>”. Marcar “Add System Stamp” y  “Add Captation”.

Igualmente, podremos, en efectos de sonido, eliminar el sonido del clip del ratón o hacer una grabación sin sonido 

· Record screen>Effects> Sound> <Mouse sound clikAnnotation>”. Marcar “Add System Stamp” y  “Add Captation”.

Los efectos del cursor están vinculados con el modelo  de cursor que deseamos utilizar durante la grabación.

Una vez definida las características de la grabación podremos iniciar la misma pulsando “Rec. o F9” Y para terminarla “Stop o F10”.

 Opciones de post-grabación

En el proceso de post-grabación podremos grabar, borrar, editar, y producir el proyecto.
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Studio Camtasia

Studio Camtasia será el laboratorio de manipulación donde podremos transformar el proyecto que estemos realizando. Por ejemplo, le añadiremos texto, audio, zoom,  o definiremos marcas para un índice, etc. Se compone de varios menús

Barra principal

 
Desde la barra principal podremos acceder a todas las opciones del proyecto, así como a la configuración del mimo. La barra está compuesta de:

· File
: podremos crear, abrir, importar, exportar, publicar, etc.  proyectos.

· Edit: tendremos la posibilidad de añadir sonido, aplicar zoom, establecer procesos de transición, añadir subtítulos,  etc. 

· View:  definiremos aquellas elementos que queremos que aparezcan en las diferentes barras de herramientas

· Play
· Tools: nos encontramos las diferentes funcionalidades de Camtasia , así como la configuración  de diferentes elementos del programa. 
Barra de lista de tareas (Task List)


Al igual que en Edit podremos añadir sonido, aplicar zoom, establecer procesos, de transición, pero además importar archivos, crear menú de cd y web y, por supuesto, iniciar la grabación de un proyecto o  de un Powerpoint.


Añadir título (title clips)

En “Title clips” añadiremos una carátula de título a nuestro proyecto, el cual adaptaremos a nuestras necesidades al poder añadir una imagen de fondo, cambiar el formato del tipo de letra, etc. Una vez terminado nuestro diseño deberemos pulsar en “Ok” y incorporarlo al principio de nuestro proyecto arrastrándolo a la zona de vídeo del “Timeline”, que es la parte inferior donde manipulamos la imagen, sonido, zoom, etc.


Grabación de voz (Voice Narration)

Nos da la posibilidad de añadir varias grabaciones, así como determinar la duración de las mismas según nuestro interés.

“Audio 1”: nos permitirá grabar el audio hasta la selección que hayamos realizado en el “Timeline”, aunque podrá sobreescribir los audios enlazados previamente.

Los “Audio 2 y 3” se pueden conjugar con audios preexistentes. 

Para la duración del audio podremos elegir entre 

· Grabar durante un periodo predeterminado en la “Timeline”, por tanto la grabación acabará automáticamente cuando hayamos llegado al final de la selección.

· Grabar hasta un punto determinado

·  Grabar automáticamente hasta el final del “Timeline”

· Grabar toda la narración hasta que la terminemos de forma manual.
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Grabación con Webcam

También podremos añadir una grabación con la webcam después de que se haya realizado el proceso de captura, lo cual nos da la oportunidad de integrar un narrador que puede dar una sensación de cercanía con el usuario.

Las opciones que nos da “Record camera” son semejantes a los de la grabación de sonidos

· Grabar durante un periodo predeterminado en la “Timeline”, por tanto la grabación acabará automáticamente cuando hayamos llegado al final de la selección.

· Grabar hasta un punto determinado

· Grabar automáticamente hasta el final del “Timeline”

· Grabar toda la narración hasta que la terminemos de forma manual.

También podremos optar por hacer la grabación con sonido o no. La integración de  vídeo de la webcam se realiza de forma automática en el “Timeline”, aunque podremos ajustarlo a nuestras  necesidades.

Una de las posibilidades que nos permite Camtasia Studio será la modificación de lo grabado con la webcam gracias a la herramienta “Picture in Picture”, que nos permitirá añadir marcos, establecer la posición, definir la opacidad, etc.  Para ello tendremos que pulsar sobre el vídeo grabado, seleccionar en “Picture in Picture” y realizar todas la modificaciones que consideremos oportunas.

Audio Enhancements


Es una herramienta destinada a la mejora de la calidad del sonido que hemos alojado en el “Timeline”. Entre las funciones que podemos realizar se encuentran: retocar el nivel de volumen del sonido,  etc.



Ver tutorial
SmartFocus


Una de las grandes ventajas de Camtasia es la posibilidad de hacer Zoom en aquellas zonas que consideremos importantes destacar. Aunque una de las posibilidades es la realización automática de zoom, también puede ser añadidos de forma manual desde la función Zoom-n-Pan.


Lo primero que tenemos que realizar es marcar en el “Timeline” el punto en el que deseamos realizar el Zoom.

· Seleccionamos “Zoom-n-Pan” > Marcamos la zona que queremos destacar con el marco verde que se nos aparece> definimos el tipo de duración de Zoom. Podremos añadiendo zonas con zoom si previamente las marcamos en el “Timeline”

Ver tutorial
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Añadir subtítulos (Captions)


Podremos añadir subtítulos y sincronizarlos con el audio. El texto podrá ser añadido, por medio de un corte y pego (“Paste”) o introducirlo manualmente (“Add”). También podemos indicar el número de caracteres que queremos por línea (nunca más de  100).  Los elementos que aparezcan en color rojo serán los que no nos quepan dentro del subtítulo que estemos creando en esa imagen.

Ver tutorial
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Camtasia, además, nos permitirá  destacar un lugar del vídeo a través de viñetas  o añadir cuestionarios en el tutorial

Produce


Una de las grandes ventajas de Camtasia es la gran variedad de formato en las que podemos realizar nuestro proyecto (swf, flv, avi, m4v, etc.). 

· Seleccionar “Produce video as”> seleccionar el tipo de material que queremos producir (web, Ipod, blog…) >Seleccionar el formato de producción (avi, sfw, mov…)> Seleccionar un “Template”> Añadir una marca de agua (si lo consideramos oportuno)> indicar el nombre del proyecto y el lugar donde queremos guardarlo> Pulsar finalizar.
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Crear un pdf multimedia

Adobe profesional nos permite desde su versión 6 crear pdf multimedia. En este caso vamos a usar la versión 9 de Adobe profesional.


Requisitos previos

· Tener un archivo en los siguientes formatos (swf, avi, flv, mp3, etc.).

· En el caso de material de vídeo y flash conocer el tamaño en que fue elaborado con el objetivo que al incorporarlo en el pdf no se distorsione. Los programas Adobe Captivate y Camtasia nos proporciona esta información a la hora de hacer la grabación.

Agregar archivos multimedia a un pdf


Abrir el documento en el que queremos añadir el elemento multimedia
· Elegir la herramienta adecuada dependiendo se trate de vídeo [image: image18.png]
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· Seleccionamos el lugar y el espacio que queremos que ocupe el elemento multimedia
· Pulsamos en “Examinar” para seleccionar el fichero swf, avi, etc.
· Desmarcamos la opción “Ajustar a proporciones del contenido” y seleccionamos “Mostrar opciones avanzadas”. 
· Seleccionaremos en “Estilo de reproducción”  Reproducir contenido en ventana flotante”  y introduciremos el tamaño del fichero que hemos incorporado

Seleccionamos “archivo de póster” que será la imagen que será visible en el pdf y que habrá que pulsar para que se abra el elemento multimedia y que será la que se plasme al imprimir el documento.

Crear un portafolio con Adobe Profesional 9

La última versión 9 de Adobe Profesional  nos permite crear un porfolio multimedia que sea capaz de recoger en un único documento diferentes formatos (doc, avi, flash, flv, ppt, etc.).
1. Archivo>Crear cartera PDF

2. Elegimos una presentación

3. Crearemos una página de bienvenida y adaptaremos su diseño a nuestras necesidades. (tipo de letra, color, etc.)
4. Seleccionaremos el diseño (colores, tipo de letra, etc.) que deseamos tenga nuestro portafolio.

5. Especificar detalles de archivo. En este apartado indicaremos aquellos elementos que consideremos que deben aparecer en el momento de visualización del archivo (nombre, descripción, etc.). Igualmente, seleccionaremos el sistema de ordenación. Deberemos tener en cuenta que no  permite hacer     una ordenación personalizada, por lo que en el 
momento de realizar los ficheros deberemos tener en consideración añadir que respete nuestra organización ( ej. 01.metalib.doc , 02. Metalib.swf, etc. )

6. Podremos igualmente añadir agregar una carpeta con documentos ya existentes

7. Publicaremos el documento. 
8. El portafolio únicamente podrá ser visto por los usuarios que tengan instalado Adobe Reader 9
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